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Chapter 1 Introduction

This document describes ASME Fox 3 SoM (System On Module) based on Atmel D21
Ultra low-power microcontroller using the 32-bit ARM® Cortex®-MO+ processor.

The ASME Fox 3 Board provides the following peripherals or modules:

SIGFOX Module

Crypto Authentication chipset

GPS Module with Embedded Antenna
Bluetooth Low Energy (BLE) Interface

The ASME Fox 3 Board is supported by the Arduino IDE for a fast and easy software
development cycle (https://www.arduino.cc/en/Main/Software).

The software can also be developed using the Atmel Studio IDE commonly preferred by
professional software engineers (http://www.atmel.com/Microsite/atmel-studio/).

1.1 Board Specifications

Characteristics Value
CPU Clock speed 48MHz
Flash Memory 256K
SRAM 32K
Connector 1 Power Jack
1 USB

1 SIGFOX antenna

1 Li-Po Battery

1 SWD Debugger

Arduino compatible PinOut

Board supply voltage

6V — 24V CC

Operative Voltage 3.3V
Temperature -40°C to +85°C
Dimensions 68x30 mm
ROHS status Compliant

Table 2: Board Specifications
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Chapter 2 Hardware

2.1 External View

Figure 1: Front View

2.2 ASME Fox 3 Block Diagram
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Figure 2: SmartEverything Block Diagram
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2.3 ATMEL SAMD21Ultra low-power ARM® Cortex®-M0+ MCU

Atmel D21 Ultra low-power microcontroller using the 32-bit ARM® Cortex®-MO0+ processor
is the core of the entire board.

Memory
256KB in-system self-programmable Flash
8KB Flash Read-While-Write section
32KB SRAM Main Memory
8KB SRAM Low power Memory

Clock Frequency
e 32.768kHz crystal oscillator (XOSC32K)

Arduino compliance
Digital i/o Pins : 20
PWM Pins: all but 2 and 7
USART: 2 (USB and TTL Digital)
Analog Input Pins: 6, 12-bit DAC
Analog Output Pins: 1, 10-bit DAC
External Interrupts: All pins except pin 4

More information can be found on the ATMEL SAMD21 Data Sheet
(See the link in Chapter 6)

2.4 Power Supply Circuitry

The board can be powered by three different power supply sources:
e External Li-Po Battery
e A6V to 24V input
e A5V Mini USB connector

WARNING:

Li-Po batteries are charged at 4,2V with a current that is usually half of the nominal
capacity (C/2). This board has a specialized chip that has a preset charging current
of 350mAh. This means that the MINIMUM capacity of the Li-Po battery shall be 700
mAh. Smaller cells will be damaged by this current and may overheat, develop
internal gasses and explode, setting the surroundings on fire.

All of the components can work with the voltage range provided by the batteries, with the
exception of the GPS module that requires at least 2.8V. For this reason, it is
recommended to use an appropriate battery pack for a long use of the GPS.
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Figure 3: Power Supply block diagram

Name Nominal Description Range
J10 3V Battery Power Supply 1.4V to 3.2V
J12 6V to 24V [External Power Supply 6V to 24V
USB 5V USB Port 5V

Table 3: Power Supply Connectors and ranges

2.5 Sigfox Module (Telit LE51-868 S)

Telit LE51-868 S module is a high performance module designed to cover the 863-
870MHz unlicensed band. It provides the Telit proprietary Star Network protocol and it is
able to act as a certified Sigfox™ gateway.

The following protocol stack is preloaded:
e LE51-868 S SIGFOX™ Network Software.
e “Star Network” Protocol stack

2.5.1 Main Features

The LE51-868 S module is a complete solution from serial interface to RF interface.

The LE51-868 module has a digital part and a RF part. The radio link on the Sigfox
network is a Half-Duplex bidirectional link.

The digital part has the following functionalities:
e Communication interface
¢ |1/O management
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e Micro controller with embedded Telit Software Stack supporting Sigfox protocol

The RF part has the following functionalities:
Frequency synthesis

Front-end

Power amplification

Packet handling

More information can be found on relevant Data Sheet (See the link in Chapter 6 )

2.6 Crypto Authentication Chip (ATMEL ATECC508A)

The ATECC508A is a member of the Atmel Crypto Authentication™ family of high-security
hardware authentication devices. It has a flexible command set that allows its usage in
many applications, including the following, among others:

Anti-counterfeiting

Protecting Firmware or Media
Exchanging Session Keys
Storing Data Securely
Checking User Passwords

2.6.1 Device Features

The ATECCS508A device includes an Electrically Erasable Programmable Read-Only
Memory (EEPROM) array that can be used for key storage, miscellaneous read/write data,
read-only, secret data, consumption logging, and security configuration.

Access to the various sections of memory can be restricted in a variety of ways, and the
configuration can then be locked to prevent changes.

The ATECC508A features a wide array of defense mechanisms specifically designed to
prevent physical attacks against the device itself or logical attacks against the data
transmitted between the device and the system

Hardware restrictions on the way keys are used or generated provide further defense
against certain styles of attack.

Access to the device is made through a standard 12C interface.

Each ATECC508A ships with a guaranteed unique 9-byte (72-bit) serial number. Using the
cryptographic protocols supported by the device, a Host system or remote server can
prove that the serial number is authentic and is not a copy. Serial numbers are often stored
in a standard Serial EEPROM, which can be easily copied with no way for the Host to
know if the serial number is authentic or if it is a clone. The entire serial number must be
utilized to guarantee uniqueness.

2.6.2 Cryptographic Operation

The ATSHA204A supports a standard challenge-response protocol to simplify
programming. In its most basic installation, the Host system sends a challenge (i.e. a
number) to the device in the Client, which combines that challenge with a secret key by
using the Message Authentication Code (MAC) command from the system and sends that
response back to the system.

This basic operation can be expanded in many ways thanks to the flexible command set of
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the ATECC508A.

For a complete explanation about the possible Cryptographic Operations check the Data
Sheet (See the link in Chapter 6 )

2.7 GPS Module with Embedded Antenna (Telit Jupiter SE868-A)

The Telit Jupiter SE868-A is a GPS Module designed to fully support GPS, QZSS,
GLONASS and it is Galileo ready. It has an embedded SMT antenna and is able to track
GPS + GLONASS (and eventually Galileo) constellations simultaneously and to provide
the position through the standard serial interface (UART)

The module software can increase the position accuracy supporting:
e Ephemeris file injection (A-GPS)
e Satellite Based Augmentation System (SBAS)
More information can be found on relevant Data Sheet (See the link in Chapter 6 )

2.8 Bluetooth Low Energy (Microchip RN4871)

The RN4871 is a small form factor, Bluetooth 4.2 Low-Energy module measuring just 9 x
11.5 x 2.1 mm. This fully-integrated module is designed for easy implementation into a
broad range of applications. Supporting the latest Bluetooth standard, it delivers up to
2.5x throughput improvement and more secure connections vs. Bluetooth 4.1 based
products.

Developers can easily interface to the device via a standard UART interface, available on
most Microcontrollers and Processors.

2.8.1 Characteristics

FCC Certified Yes

Min Temp Range -20C
Max Temp Range +70C
Op Voltage Min 1.9v
Op Voltage Max 3.6V

More information can be found on relevant Data Sheet (See the link in Chapter 6 )

The module on the board is provided with the firmware able to communicate with the
ATMEL SAMD21 MCU

A suggested App for Android is B-BLE
(https://play.google.com/store/apps/details?id=com.billy.billylightblue&hl=it)
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2.9 32Kx8 Bits EEProm (AT24C256C)

The Atmel® AT24C256C provides 262,144-bits of Serial Electrically Erasable and
Programmable Read-Only Memory (EEPROM) organized as 32,768 words of 8 bits each.

The device’s cascading feature allows up to eight devices to share a common 2-wire bus.
The device is optimized for use in many industrial and commercial applications where low-
power and low-voltage operation are essential.

The device operates from 1.7V to 5.5V.
More information can be found on relevant Data Sheet (See the link in Chapter 6 )

2.9.1 Characteristics

Low-voltage and Standard-voltage Operation—VCC = 1.7V to 5.5V

400kHz (1.7V) and 1MHz (2.5V, 2.7V, 5.0V) Compatibility

Write Protect Pin for Hardware Protection

64-byte Page Write Mode—Partial Page Writes Allowed

High Reliability—Endurance: 1,000,000 Write Cycles—Data Retention: 40 Years

2.9.2 EEprom Address
The EEProm is mapped to the following 12C address 0x57

ASME Fox 3 User Guide 11 Ver. 1.2 - 31/01/2017



2.10 Board Interfaces and Connector

Headers
é 10 SCL
- 9 SDA
~ B AREF
k J5 7 GND
ATN 1 @l - 6 3 SCK
IOREF 2 || IOH (gl 5 ~12 MISO
RESET 3 = = 4 MOSI
Vi 4o all 2 -0 Ss
~_ BV 5 2 ~9
R 1 - BT
[ GND g 2| pOWER =
vinol E o) —
AD 1 fﬂﬁ : R
Al 2 (g all 5 -4
A2 3 g oL |gll & -3
A3 ER i |
A 5[5 T
A5 6 . =) 1 RX<-0
Figure 4: Headers pinout
) L. Arduino pin label Driven by
Conn Pin Description
J4 1 Digital I/0O D8 / PWM ~8 MCU Port PAO6
14 2 Digital I/O D9 / PWM ~9 MCU Port PAO7
J4 3 Digital /O D10/ PWM SS ~10 MCU Port PA18
J4 4 Digital I/O D11 /PWM MOSI ~11 MCU Port PA16
14 5 Digital I/O D12 / PWM MISO ~12 MCU Port PA19
J4 6 Digital I/0 D13/ PWM SCK ~13 MCU Port PA17
J4 7 Ground pin GND
J4 8 Analogue Reference (used by ADC) AREF MCU Port PAO3
J4 9 12C Interface SDA SDA MCU Port PA22
J4 10 |I2C Interface SCL SCL MCU Port PA23
J5 1 Digital I/O ATN ATN MCU Port PB06
J5 2 IOREF
J5 3 Reset RESET
J5 4 3.3V
J5 5 5V
J5 6 Ground pin GND
J5 7 Ground pin GND
J5 8 External Power Supply Input VIN
J6 1 Analog I/O A0 AO MCU Port PA02
J6 2 Analog I/O Al Al MCU Port PB08
J6 3 Analog I/O A2 A2 MCU Port PB09
J6 4 Analog I/O A3 A3 MCU Port PAO4
J6 5 Analog I/O A4 A4 MCU Port PAO5
J6 6 Analog I/O A5 A5 MCU Port PB02
)7 1 Digital I/O DO / Seriall (RX) RX<-0 MCU Port PA11
J7 2 Digital I/O D1 / Seriall (TX) TX->1 MCU Port PA10
J7 3 Digital I/O D2 / PWM ~2 MCU Port PA14
)7 4 Digital I/O D3 / PWM ~3 MCU Port PA09
)7 5 Digital I/O D4 / PWM ~4 MCU Port PAO8
J7 6 Digital I/O D5 / PWM ~5 MCU Port PA15
)7 7 Digital I/O D6 / PWM ~6 MCU Port PA20
)7 8 Digital I/O D7 / PWM ~7 MCU Port PA21

Table 4: Arduino Compatible Headers
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Description

Driven by

BLE TXD MCU Port PB16
BLE RXD MCU Port PB17
BLE RTS MCU Port PB22
BLE CTS MCU Port PB23
BLE P10 1/0 Expander GPIO4
BLE P11 1/0 Expander GPIO5
BLE P32 1/0 Expander GPIO6
BLE P33 1/0 Expander GPIO7
BLE RST 1/0 Expander GPIO1

Table 5 BLE port description

Description

Driven by

SFX TXD MCU Port PB12
SFX RXD MCU Port PB13
SFX RTS MCU Port PB14
SFX CTS MCU Port PB15

SFX RADIO STS

MCU Port PBO7

SFX STDBY STS

MCU Port PB10

SFX WAKE UP

MCU Port PB11

SFX RST

1/0 Expander GPIOO0

Table 6 SIGFOX port description

Description

Driven by

GPS TXD MCU Port PA12
GPS RXD MCU Port PA13
GPS RST 1/0 Expander GPIO2

GPS FORCE ON

I/0 Expander GPIO3

Table 7 GPS/GNSS port description
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Chapter 3 Mechanical Information

3.1 Main components layout

]I 2 L1 []
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Crypto I - Telit LE51-868 S =
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- 3
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/
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Microchip
4871

oo

—
EEPROM
AT24C256 |

Figure 5: Main Component layout (top)

3.2 Mechanical Characteristics

The maximum length and width of the Smarteverything Fox 3 PCB are 2.7 and 2.1 inches
respectively, with the USB connectors, power jack and antenna extending beyond the
former dimension. Three screw holes allow the board to be attached to a surface or a
case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even
multiple of the 100 mil spacing of the other pins.

This makes the SmartEverything Fox 3 fully compatible with most shields designed for the
Uno, Diecimila or Duemilanove.

0.6 (15.24 mm)

Y
5 & [OOOooooo Coooooon) L
Tl - & —
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g E —
= | @ = £
] = E
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™ ™ E E
S -y
& 2 -
T (
. J|*
) 2.6 (66 mm) o
- 2.7 (68.58 mm) i

Figure 6: Dimensions
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Chapter 4 Software Development

The following chapters provide an overview about how a user can develop its software and
run it on the ASME Fox 3 board.

There are two main ways to develop a software, load it and debug it on the card:
e Using the Arduino IDE and Sketch Projects
e Using the Atmel Studio and Standard C/C++ language

When developing a software running on a microcontroller, it is important to have some
tools to easily debug the code and to fix what does not work as expected.

It is possible to use an external debugger like the Atmel-ICE .

(http://www.atmel.com/tools/atatmel-ice.aspx) is available.
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Chapter 5 Getting Started with Arduino IDE and Sketch Projects

5.1 Tools
The following tools are needed:

e Arduino IDE (Release 1.6.4 or newer)

e USB cable

5.2 Setup the Environment
Download and install the Arduino IDE from the Arduino web site (See the link in Chapter 6

)

The first time you run the ArduinolDE, it is necessary to load the Arduino Zero &
SmartEverything Core.

Click on the Tools -> Boards ->Boards Manager... menu entry

a| Ao 164 T e
h [Tocls| Help
Auto Format Ctrl+T
Archive Sketch
3 Fix Encoding & Reload
H Serial Monitor Ctrl+ Shift+M i
Board: "Arduine Gernma” L Boards Manager...
Port: "COM36" ! Arduino AVR Boards
il e ) Arduine Yin

Burn Bootloader GLALT L

Arduino Duemilanove or Diecimila

Figure 7: Launch Board Manager
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The two installation steps shall be done as follows:

1) Select from “Type” combo Arduino and choose Arduino SAMD Boards in order to
install the core of the Arduino Zero.

i Y

A = | |Fiter your seardh...

Arduino AVR Boards Built-In by Arduino version 1.6.7 INSTALLED

Boards included in this package:

Arduino Yun, Arduino Uno, Arduino Diecimila, Arduino Nano, Arduino Mega, Arduino MegaADK, Arduino Leonardo, Arduino Micro,
Arduino Esplora, Arduino Mini, Arduino Etharnat, Arduino Fio, Arduino BT, Arduino LilyPadUSB, Arduino Lilypad, Arduino Pro,
Arduino ATMegaNG, Arduino Robot Control, Arduine Robot Moter, Arduino Gemma.

Online helo

More info

Arduino SAM Boards (22-bits ARM Cortex-M2) by Arduino
Boards included in this package:
Arduino Due.

Online help
More info

Arduino SAMD Boards (32-bits ARM Cortex-M0+) by Arduino version 1.6.0 INSTALLED
Boards included in this package:

Arduino Zero.

Online help.

More info

Figure 8 ArduinoZero Core Installation

2) Select from “Type” combo Partner and choose the ARROW Boards in order to
install the core of the SmartEverything.

@ AnalogReadSerial | Arduino 1612 == = |

File Edit Sketch Tools Help

AnalogReadSerial §

I@Bc:ar’t‘lsf\«’!anager | = |

Type :Parmer ~ | Arrow

Arrow Boards by Axel Elettronica S.r.l. version 1.2.0 INSTALLED b
Boards included in this package:

SmartEverything Fox, SmartTutto.

Cnline help
More info

// the setup routine runs once
woid setup() {
/4 initialize serial communj

Figure 9: SmartEverything Core Installation

The installation procedure will automatically install all the necessary USB drives. Once the
installation is completed, you can connect the Board and start coding.
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If the Driver installation process does not complete successfully, follow the steps described
in Chapter 7 .

5.3 Compile the Example project

This procedure explains how to compile and download the code on the SmartEverything
Fox 3 board.

As any other Arduino boards, the SmartEverything Fox 3 has the basic examples code.

To try those examples, go to File->Examples and select one under the 01.Basics menu.

,

Edit Sketch Tools Help

Mew Ctrl+M Fis
Open Ctrle O Built-in Examples
Open Recent [ 01 Basics ' AnalogReadSerial
Sketchbook [ 02.Digital ! BareMinimum
Examples ) 03.Analeg ) Blink
Close Ctrl+ W 04.Communication [ DigitalReadSerial
Tery CtrleS 05.Control [ Fade
Save As Ctrl+ Shift+5 06.5ensors ' ReadAnalogVoltage
07.Display L
Page Setup  Ctrl+Shift+P 08 Strings N
Print Ctrl+P 09.USE R
Preferences Chl+Comma 10.5tarterkit_BasicKit 3
11 ArduinclSP 3
Quit Ctrl+ Q)
Examples for any board
SerialUSB.println{™\n Brid ,
/f first time get from ndge i

5.4 Run the software
Verify the code

;
AnalogReadSerial | Arduino 1.6.12 Ll o

File Edit Sketch Teools Help

AnalogReadSerial
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Figure 10: ArduinolDE: Verify the code

Load the software on the Connect the SmartEverything Fox 3 board.

blinkRGE | Arduing 1.6.5 Lo oS

File Edit Sketch Tools Help

hlinkRGEB
.-'r* &
Shows How to use the SmartEveryvthing BEGE Led H
created 14 Jun 2015

by Mik (smkkfamel-tech.com)

%/

int i = 0;

Figure 11: ArduinolDE: Upload the code

5.5 Importing the SIGFOX SmartEverything Board Library

The SmartEverything Fox 3 board will provide, some days after its release on the market,

some useful libraries to interface with some of its main components.

In order to include the Smart Everything library use the menu Sketch ->Include Library -

Manage Libraries.

File Edit Eh!tchl Tools Help
Verify / Compile Ctrl+R

Show Sketch Folder Ctrl+K

"WWiritefl
- 1o | Include Library ' Manage Libraries... A
1| - Add File... _
1 - Add ZIP Library...
q Demonstrate how to write m e - e =
5 The library compose the D
g Bridge
7 And the ends the green EEPROM
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Figure 12: ArduinolDE: Launch Manage Libraries interface

Once the Library Manager is started, you can filter the available libraries writing
SmartEverything, or the name of the component, in the right top text box and then you can
select the necessary library.

The procedure to download the other SmartEverything Fox 3 libraries is identical.

-

File Modifica Sketch Strumenti Aiuto

sketch_oct26a §

& Gestore librerie X
Tipo Tutti « | Argomento Tutti v | smarteverything|

sve very on puve Tace:

More info A

SmartEverything SIGFOX LE5S1-868 o, Mik Varsione 2.0.0 INSTALLED

Library code for the TELEIT LE51-868 a SIGFOX module

The LE51-868 S is a high performance certified Short Range to Long Range module designed to cover the 863-870 MHz band
working with the Telit Proprietary protocol and acting as a SIGFOX gateway.

1t has high value technical characteristics such as a -126dBm sensitivity, ultra-low power consumption and up to 15.5dBm of
Output power.

It is very easy to integrate, with small form factor and acts as a long range communication module connecting directly to SIGFOX

network

More info

SmartEverything VL6180X oy Mik Versione 1.0.1 INSTALLED

Library code for the Ambi Light & Proximity sensor from ST component. Combining an IR emitter, a range sensor and an

ambient light sensor in a three-in-one ready-to-use reflovable package.
The VLE6180X is easy to integrate and saves the end-product maker long and costly optical and mechanical design optimizations.
More info

Figure 13: ArduinolDE: Library Manager

Another way to install the supported components Library is to go to the GitHub repository
and download the zip file.
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ameltech / sme-se868-a-library @Unwatch~ 9 HStar 4 YFork 4

<> Code Issues 1 Pull requests 0 Projects 0 Wiki Pulse Graphs Settings

This is the SmartEverything library to manage the GPS component — Edit

butors

P 20 commits 7 1 branch @ 3 releases 11 5 cg

Find file

Branch: master = MNew pull request Create new file =~ Upload files

.smkkHw committed on GitHub Merge pull request #4 from gdefombelle/master | ... Clone with HTTPS @ Use SS5H
Use Git or checkout with SVM using the web URL.

examples/GPS utc speed and course tested version
https://github.com/ameltech/sme-se868-a-11 E}.
SrC remove debug macro
E) README.md Update README.md Open in Desktop Download ZIP
E) README.txt Added Cold, Hot GPS module restart APIs and a case use example

Once it is downloaded, go to the “include Library” menu and use the “Add .ZIP Library...”
item.

5.6 Official GitHub library repository
Here is the official repository where the zip file can be downloaded from:

e SIGFOX Library  (https://github.com/ameltech/sme-le51-868-library)

e GPS Library (https://github.com/ameltech/sme-se868-a-library)

e BLE Library (https://github.com/axelelettronica/sme-rn4870-library)

e EEProm Library (https://github.com/PaocloP74/extEEPROM)

The EEProm shall be initialized with these parameters
new extEEPROM(kbits_256, 1, 64, 0x57);
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Chapter 6 References and Useful Links

6.1 Data sheets

e ATMEL SAMDZ21 Ultra low-power ARM® Cortex®-M0+ MCU
http://www.atmel.com/Images/Atmel-42181-SAM-D21_Datasheet.pdf

e Crypto Authentication Chip (ATMEL ATECC508A)
http://www.atmel.com/devices/atecc508a.aspx

e Dynaflex 868Mhz Antenna (915/2)

e Sigfox Module (Telit LE51-868 S)
http://www.telit.com/sr-rf/le51-868-s/

e GPS Module with Embedded Antenna (Telit Jupiter SE868-A)
http://www.telit.com/products/product-service-selector/product-service-
selector/show/product/jupiter-se868-a/

e BLE Microchip RN4871
http://mwww.microchip.com/wwwproducts/en/RN4871

e E2Prom ATMEL (AT24C256C)
http://www.atmel.com/images/atmel-8568-seeprom-at24c256c¢c-datasheet.pdf

6.2 Tools
e Arduino IDE
e Atmel Studio

6.3 Web Sites

e Axel Elettronica — www.axelelettronica.it

e Arduino — www.arduino.cc

e Atmel — www.atmel.com

e Microhip - http://www.microchip.com/
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Chapter 7 Troubleshooting

7.1 Driver installation problems

It can happen that the installation of the driver does not automatically complete
successfully. The driver to manage the COM Port are not installed properly and the device
is reported as an Unknown Device.

If this happens, it is necessary to install the driver manually.

The correct drivers can be found on the following directory:

C:\Users\<login name> \AppData\Local\Arduinol5\packages\Arrow\hardware\samd\<installed Rel>\drivers.

. L X}

by 0 Update Driver Software - SmartEverything Fox bootloader (COMAG)
- i

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

1 SmartEverything Fox bootloader

Figure 14 Correct USB Driver installation
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